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Paper Set 1 · 04 Jun 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
A tower is 64 m high. When the sun’s altitude is 45°, then what will
be the length of its shadow?

A.  32 m

B.  64 m

C.  128 m

D.  21 m

✓

Q2 Quant
The speed of a boat in still water is 18 km/hr. If the current flows at 2
km/hr, how long will it take the boat to cover 32 km upstream?

A.  1.5 hours

B.  2 hours

C.  2.5 hours

D.  3 hours

✓

Q3 Quant
A shopkeeper buys a toy for ₹200 and sells it for ₹250. What is his
profit percentage?

A.  20%

B.  25%

C.  30%

D.  35%

✓

Q4 Quant
A bus goes from Jaipur to Kota at 60 km/hr and returns at 90 km/hr.
Find the average speed for the entire journey.

A.  72 km/hr

B.  75 km/hr

C.  54 km/hr

D.  60 km/hr

✓

Q5 Quant
P and Q start a partnership with ₹60,000 and ₹40,000, respectively.
After 3 months, Q withdraws half his investment. After 4.5 more
months, P adds ₹30,000, and Q reinvests his withdrawn amount plus
an extra ₹10,000. If the total duration is 10 months, what is the final
profit-sharing ratio of P and Q, in that order?

A.  67:135

B.  135:67

C.  145:68

D.  155:67

✓

Q6 Quant
Arun started a business with an investment of ₹12,600 and after a
few months, Tarun joined the business with an investment of
₹25,200. At the end of one year, the total profit was ₹8,905 in which,
Arjun's share was ₹3,562. For how many months did Tarun join the
business?

A.  6

B.  8

C.  9

D.  10

✓

Q7 Quant
Mohit can finish a piece of work in 15 days, and Rohit can finish the
same work in 30 days. They work together and earn a total of ₹4,500
for the job. Based on their contributions, how much should Mohit
get from the total payment?

A.  ₹1,500

B.  ₹2,000

C.  ₹2,500

D.  ₹3,000

✓

Q8 Quant
The ratio of the number of bottles in box X and box Y is 6 : 5
respectively. If six bottles are transferred from box Y to box X, then
the ratio of number of bottles in both boxes becomes 4 : 3
respectively. Find the number of bottles in box X initially.

A.  72

B.  84

C.  102

D.  126
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✓

Q9 Quant
If the mean and median of a moderately skewed distribution are 25
and 30, respectively, find the mode.

A.  35

B.  38

C.  40

D.  45

✓

Q10 Quant
If 20% of a number is added to 42, then the result is the same
number. 80% of the same number is:

A.  42

B.  52

C.  72

D.  62

✓

Q11 Quant
What sum of money (in ₹) will amount to ₹4,800 at 5% per annum
simple interest in 5 years?6928

A.  3,840

B.  3,790

C.  3,890

D.  19,200

✓

Q12 Quant
Pravin has ₹1302 with him. He divided it amongst his sons Rishi and
Shan and asked them to invest it at 10% rate of interest,
compounded annually. It was seen that Rishi and Shan got the same
amount after 13 and 14 years, respectively. How much money (in ₹)
did Pravin give to Shan?

A.  620

B.  682

C.  470

D.  782

✓

Q13 Quant
Let C be a circle with centre O and PQ be a minor arc on C. Let S be a
point on arc PQ and R be a point on the remaining arc of PQ on C. If
chord PQ subtends an angle of 106° at O, then find ∠PSQ.

A.  106°

B.  60°

C.  127°

D.  120°

✓

Q14 Quant
A number when increased by 60%, gives 3880. The number is:

A.  2425

B.  2850

C.  1212

D.  1727

✓

Q15 Quant
One pipe can completely fill a tank in 6 minutes, while another pipe
can empty completely filled tank in 7 minutes. If both the pipes are
operated together when the tank is empty, how long (in minutes)
will it take to fill half of the tank?

A.  21

B.  22

C.  42

D.  43

✓

Q16 Quant
The product of two consecutive positive integers is 506. If the
smaller of these two integers is represented by x, which of the
options below will correspond to the equation for finding out the
value of x?

A.  x2 + x - 506 = 0

B.  x2 + x + 506 = 0

C.  x2 - x - 506 = 0

D.  x2 - x + 506 = 0

✓

Q17 Quant
An article has a cost price of ₹394 and is marked at ₹1,182. If the
seller offers a 50% discount on the marked price, what will be his
profit percentage?

A.  50%

B.  49%

C.  48%

D.  51%
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✓

Q18 Quant

A.  

B.  

C.  

D.  

✓

Q19 Quant

A.  14.61

B.  10.11

C.  12.98

D.  10.13

✓

Q20 Quant

A.  

B.  

C.  

D.  
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GA

✓

Q21 GA
Which of the following Indian women boxers had NOT won a gold
medal at the World Boxing Cup in July 2025?

A.  Sakshi Choudhary

B.  Nupur Sheoran

C.  Jaismine Lamboria

D.  Meenakshi

✓

Q22 GA
Which of the following states launched ‘Gajah Mitra’ scheme to stop
the increasing number of human-elephant conflicts?

A.  Assam

B.  Meghalaya

C.  Kerala

D.  Uttarakhand

✓

Q23 GA
Which of the following is NOT an intrusive volcanic landform?

A.  Sill

B.  Batholith

C.  Dyke

D.  Caldera

✓

Q24 GA
Which of the following districts in Odisha is home to the Vedanta
Alumina Refinery?

A.  Angul

B.  Koraput

C.  Kalahandi

D.  Rayagada

✓

Q25 GA
During his visit to Ghana in July 2025, Prime Minister Narendra Modi
gifted a handcrafted silver filigree purse from Cuttack to First Lady
Lordina Mahama. This gift represents which traditional craft of
Odisha?

A.  Applique

B.  Tarakasi

C.  Lacquer work

D.  Jhoti Chita

✓

Q26 GA
Hirakud Dam on the Mahanadi—key to flood control, irrigation and
power in western Odisha—was formally inaugurated in:

A.  1953

B.  1955

C.  1957

D.  1959

✓

Q27 GA
Which legislative measure notified in 2026 by the Government of
Odisha repealed the levy of professional tax in the state?

A.  Odisha Goods and Services Tax (Amendment) Act, 2026

B.  Odisha State Tax on Professions, Trades, Callings and
Employment (Repeal) Ordinance, 2026

C.  Odisha Employment and Labour Welfare Act, 2026

D.  Odisha Fiscal Responsibility Amendment Act, 2026

✓

Q28 GA
What is the primary focus of the Sendai Framework (2015–2030)?

A.  Space technology advancements

B.  Reducing disaster risk

C.  Global trade development

D.  Increasing industrialization

✓

Q29 GA
Which Indian revolutionary and freedom fighter led the tribal
community of Bar Pir region in the Singhbhum district of Jharkhand
during the years 1857-1858?

A.  Gonoo

B.  Shah Mal

C.  Sidhu Murmu

D.  Tantia Bhil

✓

Q30 GA
Who was sworn in as the Chief Minister of Bihar following the 2025
state elections?

A.  Nitish Kumar

B.  Neeraj Sharma

C.  Anil Mehta

D.  Sudhir Yadav
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✓

Q31 GA
Which footballer was awarded the Ballon d’Or 2025, as officially
announced in October 2025?

A.  Kylian Mbappé

B.  Erling Haaland

C.  Jude Bellingham

D.  Ousmane Dembélé

✓

Q32 GA
Why are proteins important in the plasma membrane?

A.  They facilitate transport and communication

B.  They store genetic information

C.  They produce glucose

D.  They form the ribosomes

✓

Q33 GA
Which of the following describes the alignment of the Himalayas in
different regions of India?

A.  Alignment remains constant across all Himalayan regions

B.  Alignment changes from region to region across India

C.  Alignment is restricted to north–south direction only

D.  Alignment is restricted to east–west direction only

✓

Q34 GA
The 'Objectives Resolution' eventually took the form of which part of
the Indian Constitution?

A.  The Preamble

B.  The Directive Principles

C.  Citizenship provisions

D.  Fundamental Rights

✓

Q35 GA
Which of the following is the highest sporting honour in India, given
for the most outstanding performance by a sportsperson over a
period of four years?

A.  Arjuna Award

B.  Dronacharya Award

C.  Major Dhyan Chand Khel Ratna Award

D.  Indira Gandhi Khel Ratna Award

✓

Q36 GA
A student uses a compass to trace the pattern of the magnetic field
around a straight conductor. If the current is doubled, what change
will be observed in the compass needle's deflection?

A.  The compass needle will not show any deflection.

B.  The compass needle's deflection will change randomly.

C.  The compass needle will show a weaker deflection than
before.

D.  The compass needle will show a greater deflection than
before.

✓

Q37 GA
In which year did India win its first ICC Cricket World Cup?

A.  1975

B.  1983

C.  1992

D.  2003

✓

Q38 GA
Which of the following best explains disguised unemployment in
Indian agriculture?

A.  Workers are fully productive in farming activities

B.  More workers are employed than actually required for
output

C.  No workers are available in rural areas

D.  Workers are paid higher wages than urban areas

✓

Q39 GA
Which of the following is NOT a compound?

A.  Ammonia (NH₃)

B.  Carbon dioxide (CO₂)

C.  Brass

D.  Methane (CH₄)

✓

Q40 GA
Which religion was founded by Guru Nanak in the 15th century in
India?

A.  Buddhism

B.  Jainism

C.  Sikhism

D.  Zoroastrianism
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English

✓

Q41 English

In the following question, choose the appropriate option which completes the sentence. If the
sentence is correct, choose ‘No article required’.

________ Indian Ocean has the warmest surface temperature in the world.
2251

A.  A

B.  An

C.  The

D.  No article required

✓

Q42 English
Select the option that can be used as a one-word substitute for the given group of words.

A government by a few people

A.  Monarchy

B.  Oligarchy

C.  Democracy

D.  Plutocracy

✓

Q43 English
One of the following four sentences is in active voice. Select that sentence.

A.  Students are protesting against the fee hike.

B.  A new academic block is being constructed.

C.  History chapters have been revised.

D.  Spam phone calls should be blocked.

✓

Q44 English
Read the given sentence carefully. One word in the sentence is spelt incorrectly. Choose the option that has the same sentence with the correct
spelling of that word.

The geologist examined the peculiar crystel found deep inside the cave.

A.  The geologist examined the peculiar crystle found deep inside the cave.

B.  The geologist examined the peculiar crystal found deep inside the cave.

C.  The geologist examined the peculiar cristel found deep inside the cave.

D.  The geologist examined the peculiar crystaal found deep inside the cave.
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✓

Q45 English
Identify the sentence that is correctly written in the present tense.

A.  The committee finalized the proposal after several lengthy discussions.

B.  The committee had finalized the proposal before the meeting began.

C.  The committee will finalize the proposal after reviewing the report.

D.  The committee finalizes the proposal during its scheduled meetings.

✓

Q46 English
Choose the option that best replaces the highlighted words in the given sentence.

The children kept the doors locked while their parents were away, deciding that it is always better to be cautious than to regret a mistake
later.

A.  absence makes the heart grow fonder

B.  a stitch in time saves nine

C.  it is better to be safe than sorry

D.  better late than never

✓

Q47 English

Read the given passage and answer the questions that follow.

Apples are juicy, sweet, and tasty, and they are also an important part of a healthy diet. Research shows that eating apples can reduce the risk of
cancer, stroke, and heart disease. Studies at Cornell University and in Hawaii found nutrients in apples slow cancer cell growth and lower the risk
of lung cancer. Research in Finland showed men who ate apples had a lower risk of stroke, and at the University of California-Davis, apples
helped prevent harmful LDL cholesterol buildup, reducing heart attack risk.
Apples also aid digestion because they contain enzymes and fibre, particularly pectin, which lowers cholesterol. A medium apple has about 80
calories and 5 grams of fibre. Eating apples also cleans teeth and massages gums.
Apples are rich in phytochemicals, antioxidants, vitamins, and minerals like potassium and vitamin C. Phytochemicals reduce cell damage from
free radicals. Combined with other fruits, like oranges, apples improve nutrient absorption. Eating at least one apple a day supports overall
health.

Identify the central theme of the passage.

A.  Apples are nutritious and contribute to overall health.

B.  Apples are only a tasty snack with no health benefits.

C.  Fruits and vegetables are unnecessary for a healthy diet.

D.  Apple juice is more beneficial than whole apples.

✓

Q48 English
Why do apples work well with other fruits, like oranges?

A.  Apples make fruits less nutritious.

B.  Apples reduce the benefits of other fruits.

C.  Apples improve the body’s absorption of vitamin C from oranges.

D.  Apples increase the sugar content of oranges.
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✓

Q49 English
How can people use apples to support their health daily?

A.  Eat apples exclusively, ignoring other fruits and vegetables.

B.  Eat at least one apple a day as part of a balanced diet.

C.  Rely only on apple juice for nutrients.

D.  Avoid eating apples to prevent weight gain.

✓

Q50 English
Which of the following is the closest antonym for the word 'reduce'?

A.  Decrease

B.  Improve

C.  Increase

D.  Lessen

✓

Q51 English
Which of the following is true according to the passage?

A.  Eating apples can reduce the risk of cancer, stroke, and heart disease.

B.  Apples have no effect on cholesterol.

C.  Apples are high in fat and calories.

D.  Apples do not contain any vitamins or minerals.

✓

Q52 English
Find the antonym of the word given in bold:
Many students still revere their former English teacher.

A.  admire

B.  adore

C.  disrespect

D.  regard

✓

Q53 English
Select the correct option to complete the sentence with indirect speech.
The teacher said, “You must submit your assignments by Friday.”
The teacher told the students that they _______ their assignments by Friday.

A.  must submit

B.  have to submit

C.  had to submit

D.  will have to submit
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✓

Q54 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

P= Release by 2050 but has not provided
Q= Or commercial availability details
R= A definitive development timeline
S= Kawasaki envisions a potential market

A.  SPRQ

B.  RQSP

C.  RQPS

D.  PSQR

✓

Q55 English

Replace the given word segment with the correct idiom.
Someone who argues against a point just to test its strength

A.  A backseat driver

B.  A fence sitter

C.  A devil's advocate

D.  A wet blanket

✓

Q56 English
Select the most appropriate antonym of the underlined word in the given sentence.

Attendance is mandatory for all students.

A.  obligatory

B.  accessory

C.  optional

D.  temporal

✓

Q57 English
In the given question, a statement divided into different segments is given. Rearrange all the segments to form a coherent statement.

the way you will/(O) the little things/(P) do the big things/(Q) the way you do/(R) says a lot about/(S)

A.  QPROS

B.  RPSOQ

C.  QRSPO

D.  SPOQR

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q58 English
Complete the sentence by choosing the correct option.
If he _____ the lottery, he would travel around the world.

A.  won

B.  appeared

C.  explored

D.  completed

✓

Q59 English
Select the option that can be used as a one-word substitute for the underlined group of words.

Descriptions of what is going to happen to us based on the position of the stars and planets at the time of our birth often give us tips on how
to be better versions of ourselves, which can be helpful for our personal growth.

A.  Proverbs

B.  Myths

C.  Prognosis

D.  Horoscopes

✓

Q60 English
Select the most appropriate option to fill in the blank.

He was accused ______ cheating in the final exam.

A.  for

B.  with

C.  of

D.  about
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Odia

✓

Q61 Odia
କ୍ରି  ୟା ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

'' ____ କାମ କଲେ ସଫଳତା ଆସି ଥାଏ ।''

A.  ଧଯ୍ୟରେ

B.  ଧାର୍ଯ୍ୟ ରେ

C.  ଧୈ ର୍ଯ୍ୟ ରେ

D.  ଧର୍ଯ୍ୟ ରେ

✓

Q62 Odia
ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

'' ବି ନ୍ଧ୍ୟ ପର୍ବ ତ କପି ଳାସଠାରୁ  ____ ଅଟେ ।''

A.  ଉଚ୍ଚତମ

B.  ଉଚ୍ଚତର

C.  ନୀଚ୍ଚତର

D.  ନୀଚ୍ଚତମ

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ବି ପରୀତ ଶବ୍ଦ ଲେଖନ୍ତୁ
ଏହି  ନଦୀଟି  ଖୁ ବ "ଦୀର୍ଘ " ଅଟେ।

A.  ଛୋଟ

B.  ଚାପଟ

C.  ନି ମ୍ନ

D.  ଖୁ ସି

✓

Q64 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଆର୍ଯ୍ୟ ଭଟ୍ଟ ଭାରତର ପ୍ର ଥମ ଉପଗ୍ର ହ ଅଟେ ।

A.  India’s first satellite is Aryabhata.

B.  India’s first rocket is Aryabhata.

C.  Aryabhata is India’s first astronaut.

D.  Aryabhata is India’s first space center.

✓

Q65 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
The Swachh Bharat Mission encourages people to maintain cleanliness in public areas.

A.  ସ୍ୱଚ୍ଛ ଭାରତ ମି ଶନ ସାର୍ବ ଜନି କ ସ୍ଥଳରେ ସ୍ୱଚ୍ଛତା ରକ୍ଷା ପାଇଁ  ଜନତାମାନଙ୍କୁ  ପ୍ରୋ ତ୍ସାହନ କରେ।

B.  ସ୍ୱଚ୍ଛ ଭାରତ ମି ଶନ୍  ଲୋକମାନେ ସାର୍ବ ଜନି କ ସ୍ଥାନ ସଫା ରଖି ବା ପ୍ରେ ରଣା ଦେଇ।

C.  ସ୍ୱଚ୍ଛ ଭାରତ ମି ଶନ୍  ଲୋକମାନଙ୍କ ସାର୍ବ ଜନି କ ସ୍ଥାନ ସଫା ପ୍ରେ ରଣା ଦେଏ।

D.  ସ୍ୱଚ୍ଛ ଭାରତ ମି ଶନ୍  ଲୋକ ସାର୍ବ ଜନି କ ସ୍ଥାନ ସଫା ରଖି ବା ପ୍ରେ ରଣା ଦି ଏ।

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q66 Odia
"ତି ଳକୁ  ତାଳ କରି ବା"ର ଅର୍ଥ ?

A.  ଛୋଟ କଥାକୁ  ବଡ଼ କରି ବା

B.  ସଫଳତା

C.  ଭୟଭୀତ ହେବା

D.  ଲୁ ଚାଇବା

✓

Q67 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ରଜନୀ 20 ବର୍ଷ  ହେଲାଣି  ଆମ ଘରେ କାମ କରି ଆସୁ ଛି  ।

A.  Rajni is working in our house for 20 years.

B.  Rajni had been working in our house for 20 years.

C.  Rajni has been working in our house for 20 years.

D.  Rajni will work in our house for 20 years.

✓

Q68 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ |

2025 ମସି ହାରେ ପାଳି ତ ସର୍ଦ୍ଦା ର ବଲ୍ଲଭଭାଇ ପଟେଲଙ୍କ 150 ତମ ଜନ୍ମ ବାର୍ଷିକୀ ଭାରତର ଜଣେ ମହାନ ରାଷ୍ଟ୍ର ନି ର୍ମା ତା ଏବଂ ଜାତୀୟ ଏକତାର ସ୍ଥପତି ଙ୍କୁ  ସମ୍ମାନି ତ କରି ବାରେ ଏକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ
ମାଇଲଖୁ ଣ୍ଟ। ସର୍ଦ୍ଦା ର ପଟେଲ 1875 ମସି ହାର 31 ଅକ୍ଟୋବରରେ ଜନ୍ମ ଗ୍ର ହଣ କରି ଥି ଲେ | ଭାରତର ସ୍ୱାଧୀନତା ଆନ୍ଦୋଳନ ସମୟରେ ତାଙ୍କର ଅସାଧାରଣ ନେତୃ ତ୍ୱ ଏବଂ 560 ରୁ  ଅଧି କ ଗଡ଼ଜାତ
ରାଜ୍ୟକୁ  ଭାରତୀୟ ସଂଘରେ ଏକୀକୃ ତ କରି ବାରେ ତାଙ୍କର ପ୍ର ମୁ ଖ ଭୂ ମି କା ପାଇଁ  ସେ ଚି ରସ୍ମରଣୀୟ । ତାଙ୍କର ଦୃ ଢ଼ ଇଚ୍ଛାଶକ୍ତି , ପ୍ର ଶାସନି କ ବୁ ଦ୍ଧି ମତା ଏବଂ ନି ର୍ଭୀ କ ଦେଶପ୍ରେ ମ ତାଙ୍କୁ  "ଭାରତର ଲୌହ
ପୁ ରୁ ଷ" ଉପାଧି  ପ୍ର ଦାନ କରି ଥି ଲା। 150 ତମ ବାର୍ଷିକୀ ପାଳନ ଏକ ସଂଯୁ କ୍ତ, ଗଣତାନ୍ତ୍ରି କ ଭାରତର ମୂ ଳଦୁ ଆ ସ୍ଥାପନ କରି ବାରେ ତାଙ୍କ ଅବଦାନକୁ  ମନେ ପକାଇବା ପାଇଁ  ଜାତୀୟ ପ୍ର ତି ଫଳନର ଏକ
ମୁ ହୂ ର୍ତ୍ତ । ଦେଶବ୍ୟାପୀ ବର୍ଷ ସାରା, ବି ଭି ନ୍ନ କାର୍ଯ୍ୟ କ୍ର ମ ରେ ତାଙ୍କର ରାଷ୍ଟ୍ରନୀତି , ଜାତୀୟ ସଂହତି  ପ୍ର ତି  ପ୍ର ତି ବଦ୍ଧତା ଏବଂ ଦୃ ଢ଼ ଶାସନ ପାଇଁ  ଦୃ ଷ୍ଟି କୋଣକୁ  ପ୍ର ଦର୍ଶିତ କରାଯାଉଛି  । ଶି କ୍ଷାନୁ ଷ୍ଠାନ, ସରକାରୀ
ସଂସ୍ଥା, ନାଗରି କ ସଂଗଠନ ଏବଂ ଯୁ ବ ଗୋଷ୍ଠୀ ପଟେଲଙ୍କ ଶୃ ଙ୍ଖଳା, ଏକତା ଏବଂ ଜନସେବାର ଆଦର୍ଶ କୁ  ପୁ ନଃ ଆବି ଷ୍କାର କରି ବା ପାଇଁ  ସେମି ନାର, ପ୍ର ଦର୍ଶ ନୀ, ବି ତର୍କ  ଏବଂ ସାଂସ୍କୃତି କ କାର୍ଯ୍ୟ କ୍ର ମ
ମାନର ଆୟୋଜନ କରନ୍ତି । ଏହି  ଅବସରରେ ଭବି ଷ୍ୟତ ପି ଢ଼ି କୁ  ତାଙ୍କର ଅଖଣ୍ଡତା, ସାହସ ଏବଂ ଦେଶ-ପ୍ର ଥମେ ଚି ନ୍ତାଧାରାର ମୂ ଲ୍ୟବୋଧକୁ  ଅନୁ କରଣ କରି ବା ପାଇଁ  ପ୍ରେ ରଣା ଦେବା ଉପରେ ବି ଶେଷ
ଗୁ ରୁ ତ୍ୱ ଦି ଆଯାଊଛି ।

ଏହି  ଉତ୍ସବ ପାଳନ ର ଏକ ପ୍ର ମୁ ଖ କେନ୍ଦ୍ରବି ନ୍ଦୁ  ହେଉଛି  ଗୁ ଜରାଟରେ ବି ଶ୍ୱର ସର୍ବୋ ଚ୍ଚ ପ୍ର ତି ମୂ ର୍ତ୍ତି ଷ୍ଟାଚ୍ୟୁ  ଅଫ୍  ୟୁ ନି ଟି , ଯାହା ଭାରତର ଏକତା ଏବଂ ସାମୂ ହି କ ଗର୍ବ ର ପ୍ର ତୀକ ଭାବରେ ସର୍ଦ୍ଦା ର
ପଟେଲଙ୍କ ପ୍ର ତି  ଉତ୍ସର୍ଗୀ କୃ ତ। ଏହି  ଅବସରରେ, ଜାତୀୟ ସୁ ରକ୍ଷା, ସୁ ଶାସନ ଏବଂ ଗ୍ରା ମୀଣ ବି କାଶ ଉପରେ ଗୁ ରୁ ତ୍ୱାରୋପ କରୁ ଥି ବା କାର୍ଯ୍ୟ କ୍ର ମ ଗୁ ଡ଼ି କ ପଟେଲଙ୍କ ଏକ ଶକ୍ତି ଶାଳୀ, ଆତ୍ମନି ର୍ଭ ରଶୀଳ
ଏବଂ ସମନ୍ୱି  ତ ଭାରତର ବାର୍ତ୍ତା କୁ  ଆହୁ ରି  ଦୃ ଢ଼ କରି ଥାଏ। ରନ ଫର୍  ୟୁ ନି ଟି , ଜନସଚେତନତା ଅଭି ଯାନ, ପ୍ର ବନ୍ଧ ପ୍ର ତି ଯୋଗି ତା ଏବଂ ଡକ୍ୟୁ ମେଣ୍ଟାରୀ ଭଳି  କାର୍ଯ୍ୟ କଳାପ ତାଙ୍କର ଦୂ ରଦୃ ଷ୍ଟି ପୂ ର୍ଣ୍ଣ
ଅବଦାନକୁ  ଉଜ୍ଜ୍ୱଳ କରି ଥାଏ, ଯେଉଁ ଥି ରେ ଅଖି ଳ ଭାରତୀୟ ନାଗରି କ ସେବା ସୃ ଷ୍ଟି , କୃ ଷି  ସଂସ୍କାର ଏବଂ ସମବାୟ ଆନ୍ଦୋଳନର ପ୍ରୋ ତ୍ସାହନ ଅନ୍ତର୍ଭୁ କ୍ତ। 150ତମ ବାର୍ଷିକୀ କେବଳ ତାଙ୍କ ଐତି ହ୍ୟ
ପ୍ର ତି  ଶ୍ର ଦ୍ଧାଞ୍ଜଳି  ନୁ ହେଁ  ବରଂ ଏକ ସ୍ମରଣକାରୀ ଯେ ବି ବି ଧତାରେ ଏକତା ଏବଂ ନି ର୍ଣ୍ଣା ୟକ ନେତୃ ତ୍ୱ ଭାରତର ନି ରନ୍ତର ସଫଳତା ଏବଂ ପ୍ର ଗତି  ପାଇଁ  ଅପରି ହାର୍ଯ୍ୟ  ରହି ଛି । ଭାରତ ଏହି  ଐତି ହାସି କ ବର୍ଷ କୁ
ସ୍ମରଣ କରୁ ଥି ବା ସମୟରେ, ସର୍ଦ୍ଦା ର ପଟେଲଙ୍କ ଜୀବନ ସାମୂ ହି କ ଦାୟି ତ୍ୱ, ଦେଶପ୍ରେ ମ ଏବଂ ଜାତୀୟ ସଂହତି  ପ୍ର ତି  ଅଟଳ ସମର୍ପ ଣକୁ  ପ୍ରେ ରଣା ଦେଇ ଚାଲି ଛି ।

ସର୍ଦ୍ଦା ର ବଲ୍ଲଭଭାଇ ପଟେଲ କେବେ ଜନ୍ମ ଗ୍ର ହଣ କରି ଥି ଲେ?

A.  1857

B.  1875

C.  1885

D.  1890

✓

Q69 Odia
ସର୍ଦ୍ଦା ର ପଟେଲ କେଉଁ  ନାମରେ ବେଶ ଲୋକପପ୍ରି  ୟ?

A.  ସମ୍ବି ଧାନର ଜନକ

B.  ଭାରତର ଲୌହ ପୁ ରୁ ଷ

C.  ଭାରତର କ୍ଷେପଣାସ୍ତ୍ର ପୁ ରୁ ଷ

D.  ସୀମାନ୍ତ ଗାନ୍ଧୀ
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✓

Q70 Odia
2025 ମସି ହାରେ ସର୍ଦ୍ଦା ର ବଲ୍ଲଭଭାଇ ପଟେଲଙ୍କ କେଉଁ  ଜନ୍ମ ବାର୍ଷିକୀ ପାଳି ତ ହୋଇଛି ?

A.  150 ତମ

B.  140 ତମ

C.  151 ତମ

D.  145 ତମ

✓

Q71 Odia
ଷ୍ଟାଚ୍ୟୁ  ଅଫ୍  ୟୁ ନି ଟି  ର ପ୍ର ତି ମୂ ର୍ତ୍ତି କାହାକୁ  ଉତ୍ସର୍ଗୀ କୃ ତ କରାଯାଇଛି ?

A.  ମହାତ୍ମା ଗାନ୍ଧୀ

B.  ଜବାହରଲାଲ ନେହେରୁ

C.  ସର୍ଦ୍ଦା ର ବଲ୍ଲଭଭାଇ ପଟେଲ

D.  ସୁ ଭାଷ ଚନ୍ଦ୍ର ବୋଷ

✓

Q72 Odia
ସର୍ଦ୍ଦା ର ପଟେଲଙ୍କ ପ୍ର ମୁ ଖ ଅବଦାନ କଣ ଥି ଲା?

A.  ବୈ ଦେଶି କ ନୀତି

B.  ଜାତୀୟ ସଂହତି  ଏବଂ ନାଗରି କ ସେବା

C.  ମହାକାଶ ଗବେଷଣା

D.  ବାଣି ଜ୍ୟ ସଂସ୍କାର

✓

Q73 Odia
କେଉଁ ଟି  ତତ୍ସମ ଶବ୍ଦ ଚି ହ୍ନଟ କର ?

A.  ନେତ

B.  ଅନନ୍ତ

C.  ମୁ ଗ

D.  ବି ରି

✓

Q74 Odia
ଗୋବି ନ୍ଦବାବୁ  ଶ୍ୟାମକୁ  ଘରକୁ  ଡାକି ଲେ - ରେଖାଙ୍କି ତ ପଦଟି  କେଉଁ  କ୍ରି  ୟାପଦ ଚି ହ୍ନଟ କର ।

A.  ଦ୍ଵି କର୍ମ କ କ୍ରି  ୟା

B.  ସକର୍ମ କ କ୍ରି  ୟା

C.  ଅକର୍ମ କ କ୍ରି  ୟା

D.  ଅମି ଶ୍ର  କ୍ରି  ୟା

✓

Q75 Odia
ନି ମ୍ନୋ କ୍ତ ଶବ୍ଦଗୁ ଡି କ ମଧ୍ୟରୁ  ତଦ୍ଭବ ଶବ୍ଦଟି କୁ  ଚି ହ୍ନଟ କର ?

A.  ଗଧ

B.  ହସ୍ତୀ

C.  ଗର୍ଦ୍ଦ ଭ

D.  ମର୍କ ଟ

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


Computer

✓

Q76 Computer
Which tab in MS Word 2021 contains the Bullets and Numbering
options?

A.  Insert

B.  Layout

C.  Home

D.  References

✓

Q77 Computer
Which of the following best defines E-Commerce?

A.  Sharing messages and photos on social media

B.  Buying and selling goods or services using the Internet

C.  Playing online games with friends

D.  Sending emails to friends and teachers

✓

Q78 Computer
What is the right option to insert a video from your computer into a
slide?

A.  Insert → Audio → This Device

B.  Insert → Video → This Device

C.  Home → Insert Video

D.  Slide Show → Media

✓

Q79 Computer
If a user edits the Slide Master in a MS PowerPoint file that was
created using a company template, what happens?

A.  The original template is permanently changed.

B.  Changes affect only the current presentation.

C.  All PowerPoint templates update automatically.

D.  Slide Master editing is not allowed.

✓

Q80 Computer
Which feature of Excel allows you to automatically fill a series such
as “January, February, March” across cells?

A.  AutoCorrect

B.  Fill Handle

C.  Quick Analysis

D.  Data Validation

✓

Q81 Computer
Under which of the following categories does Mozilla web browser
fall?

A.  Application Software

B.  System Software

C.  Device Drivers

D.  System Utilities

✓

Q82 Computer
__________ is considered as an example of System Software.

A.  Operating System

B.  Microsoft Word

C.  Google Chrome

D.  Adobe Photoshop

✓

Q83 Computer
Which key is used for exiting the slideshow in MS PowerPoint 2007?

A.  ESC key

B.  F3 key

C.  F7 key

D.  F8 key

✓

Q84 Computer
Which of the following is NOT a print option in MS Word?

A.  Print Custom Range

B.  Print Current Slide

C.  Print Selection

D.  Print All Pages
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✓

Q85 Computer
Consider the following statements about computer components.

(1) RAM stores data temporarily and is erased when the computer is
turned off.
(2) ROM retains data even when power is lost and contains startup
instructions.
(3) CPU is responsible for performing calculations and decision-
making.
(4) PCB is software used to simulate electronic circuits.

Which of the following options is/are correct?

A.  Only 1, 2, and 3 are correct

B.  Only 1 and 4 are correct

C.  Only 2 and 3 are correct

D.  Only 1, 3, and 4 are correct

✓

Q86 Computer
Which symbol is used for multiplication in Excel formulas?

A.  X

B.  *

C.  &

D.  #

✓

Q87 Computer
In the abbreviation CPU, what does the letter 'P' stand for?

A.  Power

B.  Processing

C.  Program

D.  Protocol

✓

Q88 Computer
Identify the command that must be entered into the Run dialog to
launch Microsoft Excel.

A.  calc

B.  excel

C.  .xls

D.  spreadsheet

✓

Q89 Computer
Which device connects computers in a LAN?

A.  Monitor

B.  Router

C.  Printer

D.  Keyboard

✓

Q90 Computer
What happens when you click File → New in MS Word?

A.  It opens an existing document.

B.  It creates a blank document or opens a template.

C.  It closes the application.

D.  It saves the document.
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Reasoning

✓

Q91 Reasoning

A is the brother of F. B is the sister of A. D is
the son of B. C is the sister of D. E is the son
of D. How is A related to C?1705

A.  Mother's brother

B.  Mother's father

C.  Mother's mother

D.  Father's father
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Q92 Reasoning
Seven boxes A, B, C, L, E, Y and G are kept one over the other but not
necessarily in the same order Only one box is kept below G. Only
two boxes are kept between A and G. Y is kept above B. C is kept
above L but below A. E is not kept above L. Which box is kept fourth
from the top?

A.  Y

B.  C

C.  B

D.  L
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Q93 Reasoning
What will come in the place of ‘?’ in the following equation, if ‘+’ and ‘
– ‘ are interchanged and ‘×’ and ‘÷’ are interchanged?
25 × 5 – 12 ÷ 2 + 11 = ?

A.  18

B.  29

C.  34

D.  45
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Q94 Reasoning
HR 21 is related to KT 7 in a certain way. In the same way, NM 28 is
related to QO 14. To which of the following is IE 24 related, following
the same logic?

A.  LG 10

B.  KJ 11

C.  LK 19

D.  JH 25
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Q95 Reasoning
What should come in place of ? in the given series based on the
English alphabetical order?
GOM IMP KKS MIV ?

A.  OGY

B.  JHU

C.  POI

D.  NHY
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Q96 Reasoning
In a certain code language, ‘PAMS’ is coded as ‘5238’ and ‘MARS’ is
coded as ‘3982’.What is the code for ‘R’ in the given code language?

A.  3

B.  9

C.  8

D.  2
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Q97 Reasoning
P, Q, R, S, T, U and V are sitting in a straight line, facing the north.
Only V sits to the left of U. Only four people sit between V and Q.
Only S sits between T and P and T is not an immediate neighbour of
Q. Who sits at the extreme right of the line?

A.  P

B.  R

C.  T

D.  U

✓

Q98 Reasoning
Based on the alphabetical order, three of the following four are alike
in a certain way and thus form a group. Which is the one that does
not belong to that group?
(Note: The odd man out is not based on the number of
consonants/vowels or their position in the letter cluster)

A.  KFI

B.  MHL

C.  OJN

D.  QLP
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Q99 Reasoning
Read the given statement(s) and conclusions carefully. Assuming
that the information given in the statements is true, even if it
appears to be at variance with commonly known facts, decide which
of the given conclusions logically follow(s) from the statement(s).

Statements:
Some chairs are rabbits.
Some rabbits are games.

Conclusions (I) : Some chairs are games.
Conclusions (II) : All games are rabbits.

A.  Neither conclusion (I) nor (II) follows

B.  Both conclusions (I) and (II) follow

C.  Only conclusion (II) follows

D.  Only conclusion (I) follows
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Q100 Reasoning
Refer to the following series and answer the question. Counting to
be done from left to right only. (Note: All numbers are single digit
numbers only)
(Left) 1 2 3 3 5 4 8 9 7 1 6 5 7 5 9 8 7 5 1 2 3 5 9 8 7 9 2 1 (Right)
How many such even digits are there each of the which is
immediately preceded by a perfect square and immediately followed
by an odd digit?
(NOTE: 1 is also a perfect square)3342

A.  Seven

B.  Six

C.  Five

D.  Four
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